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CHAPTER 3 

Materials and Methods 

3.1 Materials 

Table 3.1 Chemical and reagents 

Chemical and reagents Company 

3-[(3-cholamidopropyl) dimethylammonio]-1-

propanesulfonate (CHAPS) 

Bio Basic Inc., Canada 

AccuGel (29:1) National diagnostics, USA 

Acetone Lobal Chemic, India 

Acrylamide Bio Basic Inc., Canada 

Agarose  Merck, Germany 

Ammonium persulfate (APS) Bio Basic Inc., Canada 

Bovine calf serum JR Scientific Inc., USA 

Bovine serum albumin (BSA) Sigma, USA 

Bromophenol blue BDH, UK 

Cocktail protease inhibitor set III, animal free Calbiochem®, USA 

Coomassie Brilliant Blue G-250 Bio Basic Inc., Canada 

Coomassie Brilliant Blue R-250 Bio Basic Inc., Canada 

Crystal violet Merck, Germany 

Dichloromethane Lobal Chemic, India 

Dithiothreitol (DTT) Bio Basic Inc., Canada 

Dimethyl sulfoxide (DMSO) Sigma, USA 

(3-(4,5-dimethylthiazolyl-2)-2,5-

diphenyltetrazolium bromide (MTT) 

Sigma, USA 

Dry strip cover fluid GE Healthcare, UK 

Ethanol Merck, Germany 

Ethylacetate Lobal Chemic, India 
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Table 3.1 (continued) 

Chemical and reagents Company 

Ethylenediamine (N, N, N´, N´) tetraacetic acid 

(EDTA) 
Scharlau, Spain 

Fetal bovine serum Hyclone®, USA 

Glacial acetic acid QreCtm, New Zealand 

Glutaraldehyde Sigma, USA 

Glycine Research organics, USA 

Glycerol (87%) QreCtm, New Zealand 

IPG buffer, pH 3-10 NL GE Healthcare, UK 

IPG buffer, pH 4-7 GE Healthcare, UK 

Iodoacetamide (IAA) GE Healthcare, UK 

Low molecular weight protein marker GE Healthcare, UK 

Methanol Merck, Germany 

Minimum essential medium (MEM) Hyclone®, USA 

85% phosphoric acid Scharlan, Spain 

N, N´-methylene bisacrylamide Bio Basic Inc., Canada 

N, N, N´, N´-tetramethylethylenediamine (TEMED) Bio Basic Inc., Canada 

Penicillin / Streptomycin Gibco®, USA 

Phenylmethylsulfonyl fluoride (PMSF) Bio Basic Inc., Canada 

Silica gel type 100 (70-230 mesh ASTM) Merck, Germany 

Silica gel 60 GF254  Merck, Germany 

Sodium acetate Carlo Erba, France 

Sodium bicarbonate Merck, Germany  

Sodium chloride LobaChemi, India 

Sodium dodecyl sulfate (SDS) GE Healthcare, UK 

Sodium thiosulfate Carlo Erba, France 

Shaker (platform) Major Science, Taiwan 

Thiourea Carlo Erba, France 

TLC Aluminium sheet (TLC siliga gel / 60F 254) Merck, Germany 

Trypsin-EDTA (0.5%) Gibco®, USA 

  

https://www.google.co.th/url?sa=t&rct=j&q=&esrc=s&source=web&cd=4&cad=rja&uact=8&sqi=2&ved=0CC4QFjAD&url=http%3A%2F%2Fwww.affymetrix.com%2Fcatalog%2F131244%2FUSB%2FTEMED-(N-N-N-%27N%27-Tetramethylethylenediamine)&ei=OO9WVL-qLYWhugTC6IKYAg&usg=AFQjCNFghkPg1hwJ-hYbQ00NNe_b2JLAlg&bvm=bv.78677474,d.c2E
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Table 3.2  Instruments 

Instrument Company 

Urea AppliChem GmbH, Germany 

Autoclave Sanyo, Japan 

Biosafety cabinets class II ESCO®, USA 

Cell culture flask, 25 cm2 CORNING®, USA 

Cell culture flask, 75 cm2 Cellstar®, Germany 

Cell culture plate 24 wells NUNCtm, Denmark 

Centrifuge Beckman Coulter, USA 

Refrigerated centrifuge  Hettich, USA 

Centrifuge tube Vivantis, UK 

CO2  incubator Shellab, USA 

Compound microscope Olympus, USA 

Electrophoresis apparatus GE Healthcare, UK 

Ettan IPG Strip holder 13 cm GE Healthcare, UK 

Freezer -20°C Whirlpool, USA 

Freezer -80°C New Brunswick Scientific, UK 

Immobilized (IPG) strip pH 4-7 linear GE Healthcare, UK 

Immobilized (IPG) strip pH 3-10 nonlinear (NL) GE Healthcare, UK 

Lyophylizer FTS system, USA 

Microcentrifuge Eppendrof, Germany 

Microcentrifuge tube Lab connection, Thailand 

Micropipette PZ HTL S.A., Poland 

Microplate reader Biotek, UK 

Microscope Olimpus optical, Japan 

pH meter Precisa, Switzerland 

Pipette tips Lab Connection, Thailand 

Power supply Bio Rad, UK 

Rotary evaporator BUCHI, Japan 

Spectrophotometer Thermo Fisher Scientific, USA 

Vortex mixer Scientific Industries Inc.,  

 Thailand 
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3.1.1 Cells and Viruses  

  Vero cells (African monkey kidney cell) were supported from Division of 

Microbiology, Department of Medical Technology, Faculty of Associated Medical 

Science, Chiang Mai University. The standard herpes simplex virus type 1 (strain 1F) 

and herpes simplex virus type 2 (strain 2G) was obtained from Division of 

Microbiology, Department of Medical Technology, Faculty of Associated Medical 

Science, Chiang Mai University.  

3.2 Methods 

  3.2.1 Extraction of Spirogyra spp. 

Dry powders of algae (250 grams) which were collected from the natural pond at 

Na Ku Ha Village, Suankhun district, Amphoe Muang, Phrae province, were macerated 

with 4 liter of 95% ethanol for 3 days at room temperature or soaked with distilled 

water at 45ºC in water bath for 3 hours.  Then, the suspension of algal extracts was 

filtered through filter paper Whatman No.1 (Whatman, USA).  The filtrate was 

concentrated by rotary evaporator to remove the solvent and dried by lyophilizer to 

obtain crude extracts.  Next, the dried extract was reconstituted by dimethylsulfoxide 

(DMSO, Labscan, Ireland) and stored in amber glass bottle at 4°C before investigation 

of anti-HSV activity.         

3.2.2 Anti-herpes simplex virus assay 

3.2.2.1  Cultivation of Vero cells    

  Vero cells were used throughout this study for propagation of herpes 

simplex virus and investigation of anti-HSV activity.  The cells were obtained from 

division of Clinical Microbiology, Department of Medical Technology, Faculty of 

Associated Medical Sciences, Chiang Mai University.  Vero cell were cultured as 

monolayer in Eagle’s minimum essential medium; MEM (Gibco, UK) and 

supplemented with penicillin/streptomycin (PAA, Austria).  Heat inactivated fetal 

bovine serum, 10% (Hyclone, UK) was added before use.  The cells were cultured until 

confluence at 37ºC in humidified 5% CO2 atmosphere incubator.  Vero cells were 

subcultured every 2-4 days in Biosafety Cabinet Class II.  The cells were washed twice 
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with PBS (1X) and detached with trypsin-ethylenediamine tetra-acetic acid (Trypsin-

EDTA, 0.05%, PAA, Austria).  Trypsin-EDTA was removed and growth medium was 

added.  The cells were transferred into new flask with spilt ratio of 1:3 and further 

incubated at 37ºC in humidified 5% CO2 atmosphere incubator for 3-4 days. 

 

3.2.2.2  Propagation of herpes simplex viruses   

    Standard strains of herpes simplex virus (HSV) type 1 strain F and type 2 

strain G (HSV-1F and HSV-2G) were used throughout this study.  HSV-1F and HSV-

2G were obtained from Division of Clinical Microbiology, Department of Medical 

Technology, Faculty of Associated Medical Sciences, Chiang Mai University.  Clinical 

ACV-resistant HSV-1 isolates 1A, 1B, 11, 12 and 22 were also used.  The virus at 

multiplicity of infection (MOI) of 1.0 was propagated on monolayer of Vero Cells in 25 

cm2 flask after adsorption at room temperature for 1 hour.   After adsorption period, the 

inoculum was removed by washing twice with PBS (1X).  Then, maintenance medium 

supplemented with 2% heat inactivated fetal bovine serum was added.  The infected 

cells were cultured at 37ºC in humidified 5% CO2 atmosphere incubator until 80-90% 

of cytopathic effect (CPE) of the cells was observed.  The infected cells were collected 

and virus stock was prepared by freezing and thawing of infected cells twice.   

 

3.2.2.3  Plaque titration assay    

    HSV viral stock was serially ten-fold diluted in MEM and each dilution 

of HSV was added into the confluence of Vero cells in 24-well tissue culture plate.  

After viral adsorption for 1 hour, the overlay media containing growth medium and 

1.5% sodium carboxymethyl cellulose were added to each well.  After incubation at 

37ºC in humidified 5% CO2 atmosphere incubator for 3-4 days, the cells were stained 

with 0.1% crystal violet in 1% ethanol for 20 minutes for observation of toxicity on 

Vero cell.  Then, plaques were counted and viral titers were expressed as plaque 

forming unit/ml (PFU/ml). 

 

3.2.2.4  Cell cytotoxicity    

    Cytotoxicity of Spirogyra spp. extracts was investigated on Vero cells.  

The extracts were serially two-fold diluted with MEM and each concentration of the 
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extracts was added to quadruplet wells onto 96-well tissue culture plate.  Then, Vero 

cells at concentration of 1 × 105 cells/ml were added to each well and incubated for 24 

hours at 37ºC in humidified 5% CO2 atmosphere incubator. After that, the algal extracts 

at different concentration were added to each well and incubation was carried out at 

37°C for 48 hours. Then, 15 µl of MTT (5 mg/ml) was added to each well and incubated 

at 37°C in 5% CO2 incubator for 4 hours.  Finally, DMSO was added in each well to 

form MTT-formazan product.  Determination of cell viability was performed using 

ELISA reader by measuring the absorbance at 540 nm with reference wavelength at 630 

nm. 

 

3.2.2.5  Plaque reduction assay  

    Vero cells were grown as monolayer in 24-well tissue culture plates.  

Each well was infected with 50-100 PFU of HSV and incubated on rocking platform                   

for 1 hour at room temperature for viral adsorption to the cell.  Then, Spirogyra spp.  

extracts or fractions at non-toxic concentrations and ACV at 50% effective dose (ED50) 

were added to the cells and overlaid with overlay medium.  After incubation for 3-4 

days at 37ºC in humidified 5% CO2 atmosphere incubator, the extracts were removed 

and washed once by PBS (1X).  Then, the cells were stained with 0.1% crystal violet in 

1% ethanol for 20 minutes.  The number of plaques was counted comparing with 

untreated virus control and expressed as plaque forming unit per ml (PFU/ml).  50% 

effective dose (ED50) was expressed as 50% inhibition of plaque formation and 

calculated by dose-response curves.  

 

3.2.2.6  Acyclovir   

     Acyclovir (ACV, Vilerm), 0.10 g was dissolved in 1 ml of sterile 

deionized water and stored in -20°C before use.  ACV was diluted in MEM and tested 

against both types of HSV.  ACV at 50% effective dose (ED50), which was the dose that 

inhibited HSV infection by 50% was determined and selected as positive control when 

investigation of anti-HSV activity.   

 

3.2.2.7  Mechanism of Spirogyra spp. extracts on HSV inhibition  

(1)  Inactivation kinetic    
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   Inactivation kinetic of the Spirogyra spp. extracts on HSV particles was 

investigated.  HSV was treated with the highest non-toxic concentration of algal 

extracts.  The mixture of Spirogyra spp. extracts was incubated at room temperature for 

60, 120, 180 and 240 minutes.   

  The mixture was collected at the end of each incubation period and kept 

at -80ºC.  Titers of residual virus after treatment with Spirogyra spp. extracts were 

determined by plaque titration assay and the percentage of viral particles inhibition by 

algal extracts was calculated and compared to untreated virus control.    

 

(2)  Effect of  Spirogyra spp. extracts on HSV  before viral  

      attachment 

  Effect of Spirogyra spp. extracts on viral attachment to cellular receptor 

was evaluated.  Various non-toxic concentrations of Spirogyra spp. extracts were added 

into a confluence of cell monolayer in 24-well tissue culture plate and incubated at 

room temperature for 1 hour.  After that, the extracts were removed and the cells were 

washed with PBS (1X) once.  Then, 50-100 PFU of virus was added and overlaid with 

overlay media.  The inoculum was incubated at 37ºC in humidified 5% CO2 atmosphere 

incubator for 3-4 days.  After incubation, the overlay media were discarded and plaques 

were stained with 0.1% crystal violet in 1% ethanol for 20 minutes.  Percentage of HSV 

inhibition was determined by calculation of plaque number after treatment with algal 

extracts comparing with antiviral agent, ACV and virus control.  ED50 values of algal 

extracts on HSV inhibition were also calculated by dose-response curves and expressed 

as concentration that plaque formation was inhibited by 50%.     

   

(3) Effect of Spirogyra spp. extracts on HSV during viral attachment 

   Effect of Spirogyra spp. extracts on viral attachment to cell culture was 

investigated.  The Spirogyra spp. extracts at various non-toxic concentrations and 100 

plaques/0.1 ml of HSV were added into monolayer of Vero cell in 24-well tissue culture 

plates.  Then, the virus was adsorbed at room temperature for 1 hour on rocking 

platform.  After that, the inoculum was removed before overlaid with overlay medium 

and incubated at 37ºC in humidified 5% CO2 atmosphere incubator for 3-4 days.  After 

incubation period, the numbers of plaques were counted after stained with 0.1% crystal 
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violet in 1% ethanol for 20 minutes and percentage of inhibition was determined by 

calculation of plaque number compared to untreated viral infected cells control.  ED50 

values of algal extracts on HSV inhibition were also calculated by dose-response curves 

and expressed as concentration that plaque formation was inhibited by 50%.  

  

(4)  Effect of Spirogyra spp. extracts on HSV after viral  

       attachment 

   Vero cells were cultured as monolayer at 37ºC in humidified 5% CO2 

atmosphere incubator in 24-well tissue culture plates.  Then, 100 plaques/0.1 ml of HSV 

were added for 1 hour at room temperature on rocking platform.  After that the cells 

were treated with various concentrations of Spirogyra spp. extracts and overlaid with 

overlay medium before incubation for 3-4 days at 37ºC in humidified 5% CO2 

atmosphere incubator.  Then, media was discarded and infected cells were stained with 

0.1% crystal violet in 1% ethanol for 20 minutes.  Percentage of inhibition was 

determined by reduction of plaque number comparing to untreated virus control.   ED50 

values of Spirogyra spp. extracts on HSV inhibition were also calculated by dose-

response curves and expressed as concentration that plaque formation was inhibited by 

50%.   

   

(5)  Effect of Spirogyra spp. extracts on HSV multiplication   

  Effect of Spirogyra spp. extracts on viral multiplication was determined.  

Vero cells were grown as monolayer in 6 well tissue culture plates.  The cells were 

infected with 1x106 PFU/ml of HSV for 1 hour at room temperature on rocking 

platform.  After that, the inoculum was removed and unattached virus was washed twice 

by PBS (1X).  Then, the highest nontoxic concentrations of algal extracts were added to 

each well and incubated at 37ºC in 5% humidified CO2 atmosphere incubator.  ACV at 

ED50 concentration and MEM were used as positive and negative control, respectively.  

Infected cells were collected at 0, 6, 24, 30 and 36 hours after viral infection.  

Moreover, Spirogyra spp. extracts that showed the strong inhibition of HSV 

multiplication were selected and used at lower concentration to compare inhibitory 

activity against HSV multiplication cycle.  After that the cells were frozen and thawed 
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twice and virus in supernatant was kept at -80ºC before determination of virus titers by 

plaque titration assay. 

 

3.2.3  Separation and partial purification of Spirogyra spp. extracts  
 
Spirogyra spp. extracts  that showed the highest anti-HSV activity were selected 

and separated by partition technique and subsequently further purified using column 

chromatography to identify the major secondary metabolites.  The procedure of 

separation was as follows. 

 
3.2.3.1  Separation of Spirogyra spp.  extracts by partition technique    

  Crude extracts of Spirogyra spp. extracts, which showed the highest anti 

HSV activity were separated by partition technique.  Different solvent based on polarity 

was  used.  Distilled water (56 ml) was initially added to 25.0 g of dried powder of 

extract before it was partitioned with 50 ml of hexane in separatory funnel four times to 

give the fraction.  The residual of extracts was further partitioned by gradually 

enrichment with 50 ml of ethyl acetate four times to give the EtOAc fraction.  Then, the 

supernatant were selected and further partitioned with dichloromethane fraction.  

Finally, each partition fractions were dried in high vacuum to obtain dry yield of four 

fractions and the fractions of extracts were further dissolved in DMSO before testing for 

their anti-HSV activity by plaque reduction assay.  
 

3.2.3.2  Isolation of Spirogyra spp. extracts 

  The ethanolic and methanolic extract of Spirogyra spp. (100 g) was 

fractionated by column chromatography using silica gel as stationary phase.  The silica 

gel was mixed with each Spirogyra spp. extract and packed in column and elution was 

started with eluted solvent; dichloromethane, EtOAc, 95% EtOH and methanol 

consecutively.  Each 20- 25 ml fraction was collected and combined after visualization 

with TLC using ultraviolet light (254 and 366 nm).  The isolation of Spirogyra spp. was 

performed. 

  After that, each fraction was dried in high vacuum and dissolved in 

DMSO before study the efficacy against HSV activity by plaque reduction assay. 
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3.2.3.3  Thin layer chromatography (TLC) 

   Identification of phytochemical constituents was further carried out by 

TLC using pre-coated silica gel 60F 264 (Merck, Germany) as an adsorbent with layer 

thickness of 0.2 mm and 5 cm distance.  First, a small spot of each sample solution was 

applied to a silica gel plate at starting point about 1 cm from the base and the plate was 

placed in to saturated solvent chamber system.  Different compounds in the sample 

mixture could move at different rates due to differences in solubility in the solvent and 

stationary phase.   Then, TLC plate was removed after the solvent moved to the solvent 

point and air-dried at room temperature.  After that, the numbers of spots on the 

developed plates were observed under UV light at 365 nm.  Spots were visualized by 

spraying with 2% anisaldehyde-sulfuric acid reagents to determine the different 

compounds following by heating in oven at 110ºC for 5-10 minutes.  Colorful spots of 

positive control after spraying this reagent were varied depending on the compound 

observed.  In addition, Rf values of each spot were calculated and measured as follows. 

 

 
 

Rf  =      Distance of the tested solution 

                    Distance of the solvent 

 

 

 

 

 

 

 

 

 

   

   

 

 

Start point 

Solvent point 

4 cm Start point to center of 
spot of tested solution 

×
   

5 cm 
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3.2.3.4  Determination of phytochemical compounds in Spirogyra spp.   

extracts  

  Phytochemical compound in crude extracts and fractions of the algal 

were investigated in this study.  The major compounds of the algal extracts were 

identified for secondary metabolite constituents such as alkaloids, antraquinones,  

lactone, essential oil, terpenoid, steroid, flavonoid, phenolics and tannins using 

reference  phytochemical test.    
 

   (1)  Detection of alkaloids by Dragendorff’s reagent 
 

   Alkaloids were determined by dissolving 0.3 g of the powdered extracts 

in 15 ml of 2N hydrochloric acid (HCl) and incubated in water bath for 10 minutes.  

Then, the mixture was cooled and filtered using Whatman No. 1 filter paper.  After that, 

2 ml of filtrate was divided into 4 tubes and each individual tube was treated carefully 

with various alkaloid reagents.   

   A few drops of Mayer’s reagent (Potassium Mercuric Iodine) were added 

to the filtrate of the first test tube.  A turbid or white color of precipitate indicated the 

presence of alkaloids in the filtrate.  An orange or reddish color of precipitate indicated 

the presence of alkaloids, was observe after adding a few drops of Dragendorff’s 

reagent (Solution of Potassium Bismuth Iodide) to the filtrate of the second test tube.  A 

few drops of Wagner’s reagent (Iodine in Potassium Iodide) were added to the filtrate of 

the test tube.  A brown or reddish color of precipitate indicated the presence of 

alkaloids.  A few drops of Hager’s reagent (Saturated picric acid solution) were added 

to the filtrate of the fourth test tube.  A yellow color of precipitate indicated the 

presence of alkaloid 
 

   (2)  Detection of antraquinone by potassium hydroxide 
 

   Potassium hydroxide’s reagent was used to identify antraquinone. 

Briefly, 0.2-0.5 g of the extract was mixed with 20 ml of KOH in the test tube and 

incubated for a few minutes on water bath for 5 minutes.  Then, the layer was collected 

and 1N NaOH was added to the layer.  Formation of rose-pink or red of alkaline layer 

indicated the presence of antraquinone.    
 

   (3)  Detection of lactone by Kedde’s test 
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   3,5-Dinitrobenzoic acid was used to identify lactone. Briefly, 0.2-0.5 g of 

the extract was mixed with 10 ml  of  3,5-Dinitrobenzoic acid in the test tube.  Then, the 

layer was collected and 1N NaOH was added to the layer.  Formation of rose-pink or 

violet of alkaline layer indicated the presence of lactone.     
 

   (4)  Detection of essential oil by phosphomolydic acid 
 

   Phosphomolydic acid in 95% EtOH was used to identify essential oil. 

Briefly, 0.2-0.5 g of the extract was mixed with 10 ml  of  phosphomolydic acid in the 

test tube.  Then, the layer was sprayed on the layer.  Finally, the layers were incubated 

in 105°C before presence the formation of deep blue or black of alkaline layer indicated 

the positive of essential oil.      
 

(5)  Detection of terpenoid by sulfuric acid   
 

   Sulfuric acid  in 5% EtOH was used to identify terpenoid. Briefly, 0.2-

0.5 g of the extract was mixed with 10 ml  of  sulfuric acid  solution in the test tube.  

Then, the layer was sprayed on the layer.  Finally, the layers were incubated in 105°C 

before presence the formation of brown or  red-violet of alkaline layer indicated the 

positive of terpenoid. 
 

   (6)  Detection of flavonoid and tannins by ferric chloride   
 

   Ferric chloride solution was used to identify flavonoid and tannins.  

Briefly, 0.2-0.5 g of the extract was mixed with 10 ml of ferric chloride solution in the 

test tube and   incubated  for a few minutes on water bath for 5 minutes.  The formation 

of blue-gray, gray and blak of alkaline layer indicated the positive of flavonoid and 

tannins. 
 

3.2.4  Effect of Spirogyra spp. extracts on HSV viral DNA  
 

Viral DNA was extracted from infected cells after treatment with and without 

algal extracts. These cells were harvested and lysed in lysing solution containing 5M 

NaCl, 10 mg/ml proteinase K and 10 mg/ml RNAse and incubated at 37°C.  After 1 

hour, the suspension was centrifugated and proteins were separated by phenol-

chloroform extraction method. Then, the supernatant was dissolved in distilled water. 

Isolated HSV DNA were determined by real time PCR comparing to control. 

3.2.5  Sample collection of HSV infected cell for proteomics analysis  
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         The culture medium was removed to 15 ml centrifuge tube, then 5 ml of ice cold 

1X PBS was added.  After that the cell monolayer was scraped with cell scraper.  The 

mixture was poured in the 15 mL centrifuge tube and keep in ice box,  5 mL of ice cold 

1X PBS was added.  Next, cell suspension was centrifuged at 4°C, 1,200 rpm for 5 

minutes and the supernatant was removed.  The cell pellet was mixed with 1 mL of ice 

cold 1X PBS, then centrifuged at 4°C, 3,000 rpm for 10 minutes.  Finally, the 

supernatant was removed, the cell pellet and culture medium were stored at -80°C until 

analysis. 

3.2.5.1  HSV protein extraction for proteomics 

   The protein sample and cell culture were mixed with rehydration buffer 

(8 M urea, 2 M thiourea, 48 mM DTT, 4% (w/v) CHAPS, 10% isopropanol, and 5% 

isopropanol) for 50-200 µL. Then, the protein cocktail inhibitor (Calbiochem®, USA) 

was added and mixed gently before further analysis. 

3.2.5.2  Determination of total protein concentration   

   Total protein concentration were measured following the method as 

described by Bradford assay.  The protein samples was bound with Coomassie Brilliant 

Blue G250 dye (Bio Basic Inc., Canada).  Under acidic condition, the dye is expressed 

in protonated red cationic form.  After the proteins bind to the dye, they are converted to 

a stable unprotonated  blue anionic form.  The absorbance of the solution was measured 

at 595 nm.  For a standard curve, BSA was used as a standard solution.   

3.2.5.3  Analysis of protein pattern by SDS-PAGE 

   Sodium dodecyl sulfate-polyacrylamide gel electrophoresis (SDS-PAGE) 

is a technique which is used for mornitor the protein pattern after total protein 

concentration was examined.  12.5% SDS was used and the apparatus were cleaned with 

70% (v/v) ethanol.  The polyacrylamide gels were prepared, which consisted of 

resolving gel solution and stacking gel solution.   

(1) 12.5% SDS-PAGE preparation   

    The glass cassette were assembled.  The resolving gel was 

prepared following the detail that illustrated in Table 3.3.  The casting frame was placed 

into the casting stand.  Then, the glass plate was marked at 1.5 cm below the comb teeth.  

Gel mixture were prepared by APS and TEMED were added.  Then, the gel was 
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prepared into the gel casting and surface of resolving gel was covered with cold 70% 

ethanol. The gel was allowed to polymerize for 30 minutes.  Next, 70% ethanol was 

removed and stacking gel was prepared.  The air bubbles should be avoid during gel 

preparation.  The comb was put into the 4% stacking gel layer and stacking gel was 

allowed to polymerize at least 30 minutes.  Finally, the casting stand was moved into 1X 

electrophoresis buffer and the comb was removed.      

Table 3.3 The solution mixture for preparation of 12.5% SDS-PAGE 

Type of gel solution Chemicals Volume (ml) 

12.5% resolving gel 

solution 

30.0% 29:1 (acrylamide:bisacrylamide) 4.17 

1.5 M Tris-HCl, pH 8.8 2.50 

Steriled DI water 3.12 

10.0% (w/v) SDS 0.10 

10.0% (w/v) APS 0.10 

TEMED 0.01 

4.0% stacking gel 

solution 

30.0% 29:1 (acrylamide:bisacrylamide) 1.33 

1.0 M Tris-HCl, pH 6.8 2.50 

Steriled DI water 6.01 

10.0% (w/v) SDS 0.10 

10.0% (w/v) APS 0.05 

TEMED 0.01 

   (2) Protein sample preparation and electrophoresis 

    Protein sample was prepared before separation in 12% SDS-

PAGE, 15 µg of protein sample was mixed with 3X loading sample buffer in the volume 

of 1/3 protein sample in 1.5 mL of steriled microcentrifuge tube.  Then, the sample was 

mixed gently and incubated at 95°C for 5 minutes and the sample was immediately 

stored in the ice.  Next, the mixture was centrifuged at 13,000 rpm for 15 seconds to 

eliminate the steam on the lid of microcentrifuge tube.  After that, 3 µL of low molecular 

weight protein marker and protein samples were added into each well of 12.5% SDS-

PAGE gel.  The power supply voltage was set at 80 volts for SDS-PAGE running, and 

stopped when the dye front reached the bottom of gel.  Finally, the glass cassette was 

diassembled and gels were stained with Coomassie  Brilliant Blue R-250.  
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(3) Gel staining  

            The gel was stained with Coomassie  Brilliant Blue R-250 until 

the band of proteins appeared within the clear background.  Next, the gel  was stored in 

DI water overnight and dried in cellophane membranes. 

3.2.5.4  Two-dimensional gel electrophoresis (2-DE) analysis 

   The effect of Spirogyra spp. extract on the global protein of HSV 

infection cells  was studied in this experiment.  Protein samples were separated by IEF 

and used IPG strip (pH 3-10, nonlinear and pH 4-7) before running 12.5% SDS-PAGE. 

   (1)  First dimension : Isoelectric focusing (IEF)  

    Isoelectric focusing (IEF) is the method for separate protein 

according their isoelectric point (pI).  This study used 13 cm IPG strip, pH 3-10 

nonlinear for secretomome analysis and pH 4-7 for intracellular protein analysis.  The 

250 µg protein sample was  mixed with 2.0% IPG buffer and rehydration buffer.  Next, 

the plastic cover of IPG strip was removed and IPG strip was embedded into the strip 

holder then the protein sample was loaded.  After that, the surface of IPG strip was cover 

with Immobilined DryStrip Cover solution at the volume of 400 µL.  Finally, the lid of 

strip holder was slided onto strip holder and the strip holder was put into Ettan IPGPhor 

II Manifold.  The strip was allowed to rehydration step for 12 h until the end process by 

following program. 

Prot#8  13 cm pH 3-10 NL / 13 cm pH 4-7 

Rehydration 12:00 Hr @20°C 

IEF  @20°C 50µA/strip 

2 strips 5 steps 

S1 Step and hold  120V  200Vhr 

S2 Step and hold  500V  500Vhr 

S3 Gradient           1000V  800Vhr 

S4 Gradient           8000V         11300Vhr 

S5 Step and hold           8000V           4400Vhr 
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   At the end of program running, IPG strip was removed from Ettan IPG 

Phor II and rinsed IPG strip with steriled DI water before run second dimension.  

            (A)             (B)         (C) 

Figure 3.1 Sample loading and IPG strip preparation for IEF  (A) Load sample into strip 

holder. (B) Place IPG strip onto strip holder and (C) Positioning the IPG strip, avoid air 

bubbles from cathode end to anode end. 

 

  (2)  Second dimension: SDS-PAGE 

    The second dimension for protein sample separation was 

performed after IEF step by SE 600 Ruby (GE Healthcare). The glass cassette were 

assembled.  The resolving gel was prepared following the detail that illustrated in Table 

2.4.  The casting frame was placed into the casting stand. Then, the glass plate was 

marked 5 mm below the top of glasses.  After the gel mixture were added, APS and 

TEMED were added for degassed.  Then, the surface of resolving gel was covered with 

70% cold ethanol and allowed to gel polymerize for 30 minutes.  Next, 70% ethanol 

was removed and the gel was stored in sterile water overnight at 4°C before use. 

(2.1)  IPG strip equilibration 

    IPG strip was equilibrated before SDS-PAGE running.  SDS 

equilibrium buffer was performed.  Then, the equilibration buffer was divided to 2 tubes.  

Each tube, DTT and IAA were added into the equilibration buffer and adjusted the total 

volume to 5 mL at the final concentration 10 mg/mL and 25 mg/mL, respectively.  Next, 

the equilibration buffer mixture with DTT was aliquoted to 2.5 mL in each tube.  IPG 

strip was placed into the falcon tube with the equilibration buffer with DTT, sealed the 

falcon tube with paraflim and embedded the falcon tube to the rotating platform at 50 

rpm for 15 minutes.  After that, the IPG strip was transferred to  the equilibration buffer 

with IAA, sealed the tube with parafilm and rotated the tube on the rotating platform at 
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50 rpm for 15 minutes.  Finally, IPG strip was rinsed with steriled DI water before 

separation by SDS-PAGE. 

(2.2) Electrophoresis 

    IPG strip was placed on the top surface of SDS-PAGE gel and 

avoided air bubble. After that, the 3x3 mm2 of sterlied filter paper with 3 µL of low 

molecular weight protein marker was added at the space of anode end.  Then, the top of 

SDS-PAGE was sealed with 1% (w/v) agarose sealing solution which containing 

bromophenol blue.  Next, the SDS-PAGE running apparatus was moved into the SE 600 

RubyTM tank with the SDS-PAGE 1X running buffer and connected to the power supply.  

The electrophoresis program was set as described below. 

 

Step Currents (mA/gel) Approximate running duration (h : min) 

1 15 0 : 15 

2 40 2 : 00 – 5 : 00 

   

    This step was run until the dye front appeared at the bottom of 

SDS-PAGE gel.  Then, the gel was removed from the glasses and the gel was stained 

with Coomassie Brilliant Blue G-250.  

  (2.3) Detection of the protein spots using Coomassie Brilliant 

Blue G-250  

    After SDS-PAGE electrophoresis, the proteins were separated 

and fixed in the fixation solution for 1 h and then the fixation solution was removed.  

Next, the gel was stained with the working solution of Coomassie Brilliant Blue G-250 

for overnight.  After that, the gel was destained with steriled DI water until the protein 

spot appeared on the clear background.  Finally, the gel was scanned using Lab Scan 5 

program. 

3.2.5.5  Image gel analysis  
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                        (1) Work space creation 

   The ImageMaster 2D Platinum programe was operated and the window 

of ImageMaster was opened.  Next, the workspace was created.  After the work space 

was created, the project name and other details were set up.  Next, the class or group of 

gel images was filled in the folder and then saved the data (Figure 3.2). 

 

 

Figure 3.2 The new project creation. 

 

  (2)  Contrast adjusting 

       The project was set to the active project and the gel images on the right 

table were opened.  In addition, the gel images were adjusted the contrast by using 

adjust contrast mode. 

 (3)  Spot detection 

       Before spot detection process, the detection parameters were set.  The 

value of smooth, min area and saliency were set as 2, 5 and 1.0, respectively (Figure 

3.3). 
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Figure 3.3  The spot detection parameter setting. 
 

 (4)  Spot editing 

        After the process of auto spot detection was performed,  the spots 

were edited such as split, grow, reduce and merge the protein spots (Figure 3.4). 

 

 

 

 

 

 

 

 

Figure 3.4  The spot editing parameter 

 

  (5)  Gel matching 

        In this step, the landmark was created and  the reference gel was 

selected.  Then, all of the gel images were matched using “Auto-Match gels” function in 

the menu bar.  After that, the gel images were paired and the vecters was checked.  If  

the mismatch pair of the protein spots were appeared, the mismatch point was edited by 

choosing the “Add” or “Delete” at the menu bar (Figure 3.5). 
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Figure 3.5  The landmark of protein spot setting and                                                                   

vector direction of the protein spots. 

    

  (6)  Data analysis 

       In the process of data analysis, choosing “ Analyze > Class report…” 

at the menu bar.  Then, the window of class report was opened and choosing “Ratio” on 

the up-right of the window.  After that, the data was analyzed by statistic analysis with 

student T test.  Next, the spot ID was labeled and added color.  The histogram of the 

protein spot was shown and 3D view of protein spots were displayed by click “3D view” 

(Figure 3.6). 

 

 

 

 

 

 

 

Figure 3.6  The 3D view of the protein spots and protein spots creation. 
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  (7)  pI and MW setting on gel 

       The pI and MW of protein spot was created by choosing “View > Grid 

Lines > Show…” at the menu bar.  The pH and MW of protein spots were marked at the 

corner of the gel image.  The information of pI and MW of protein spots were showed 

after click “Window > Information” and moved the curser to the protein spot (Figure 

3.7). 

 

 

 

 

 

 

 

 

Figure 3.7 Setting of pI and MW. 

 
 

3.2.5.6  MS analysis 

  Data analysis step of protein spot in 2-DE gel, the selected protein spots 

were picked up from 2-DE gels and storaged in steriled microcentrifuge tube with 

steriled water.  The protein spot samples were analyzed with LC-MS/MS at Proteomics 

Research Laboratory, National Center for Genetic Engineering and Biotechnology 

(Biotec), Thailand.  The protein samples were digested with trypsin and the peptide 

products were separated by high-performance liquid chromatography (HPLC).  After 

that, the fractions of mixture were manipulated through mass spectrometer using 

electrospray ionization (ESI) technique and the ions were separated by hybrid analyzer 

or quadrupole-time-of-flight (Quad-ToF) analyzer.  Finally, the ion was detected 

resulting in MS/MS data. 
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3.2.5.7  Protein identification using peptide mass fingerprint data 

   The PMF or MS/MS Ion Search (STITCH) data, which was obtained 

from individual protein spot, was searched for its peptide sequence using Mascot 

program (available at http://www.matrixscience.com/). The databases from SwissProt 

and NCBInr  were used for peptide sequence searching. The taxonomy using in this 

study were “Primate”, “Mammals” and “Viruses”. The fixed and variable modifications 

were set as “Carbamidomethyl (C)” and “Oxidation (M)”, respectively. The mass values 

and peptide mass tolerance were “Monoisotopic” and “±1.2 Da”. The results were 

reported in the scores of peptide match to database.   

3.2.5.8  Protein interaction and associated  identification 

   After data analysis was employed, the name of the interest proteins were 

manipulated through STRING database version 9.1 (http://string-db.org/) to search for 

protein interaction and association.   

  3.2.6  Development of algal gel product for treatment of HSV infection  
 

 Spirogyra spp. extract, which showed the highest anti-HSV activity was selected 

and used to prepare anti-viral gel product. The algal extracts at highest non-toxic 

concentration was added to gel base (Sangtongdee et al., 2006), which contained 

carbopol, methyl paraben, propylene glycol, tween 80, triethanolamine and distilled 

water.  The contents were mixed thoroughly by homogenizer.  After that, the algal gel 

was tested against standard  HSV-1F  and HSV-2G  using plaque reducing assay.     

   

(1)  Stability test of  algal gel product (modified from Boonmachai, 2010)   

 The algal  gel containing Spirogyra spp. extract was produced.  Then, the algal 

gel was stored at different temperatures which were 4, 25 and 45ºC for 210 days.  

Moreover, the stability of algal  gel and efficacy against HSV infection were determined 

every month for 7 months. 

 

   (1.1) Physical properties determination 

  The stability of gel and physical properties were observed such as the 

separation of layer, homogenization, color, smell, pH and intensity. 
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   (1.2) Toxicity of herbal gel product 

  The toxicity of the algal  gel product was performed on Vero cell.  
 

   (1.3) The efficiency of the algal gel product against HSV-1F and HSV-

2G infection was investigated by plaque reduction assay. 
 

(1.4) Stability of the algal gel product  

  Heating-cooling cycle of algal gel was performed.  The algal gel was 

kept at 4ºC for 48 hours and then kept at 45ºC for 48 hours for 6 cycles and anti-HSV 

activity were tested by plaque reduction assay.  Physical properties were also 

determined such as pH, viscosity, color and odor. 
 

   (1.5) The irritation test and satifaction of  algal gel product on volunteers 

skin  
 

  Irritation test of algal gel product to the skin was tested in 30 healthy 

volunteers. The algal gel was applied on a surface area approximately was 1 × 1 cm2 of 

lateral arms compared with deionized water.  The gel was further washed to remove any 

remaining gel residue after 24 hours of the test.   The tested skin was observed for the 

irritation and satification  record.  

 

3.2.7   Statistical analysis 

 All values were given as mean ± standard deviation (SD) from triplicate samples 

of three independent experiments for antiviral assay.  Data values of cell viability assay 

was expressed as means ± SD from triplicate experiment.  Different alphabets were 

considered statistically significant when p < 0.05. 

   

 


